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PREFACE

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure is described in the sections identified below:

1 System Configuration

This section lists the types of External 

Devices and SIO that you can connect.

"1 System Configuration" (page 3)

2 External Device Selection

Select a model (series) of the External 

Device and its connection method.

"2 External Device Selection" (page 7)

3 Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Communication Settings" (page 8)

4 Setup Items

This section describes communication 

setup items on the Display.

Set the Display’s communication settings 

in GP Pro-EX or in offline mode.

"4 Setup Items" (page 52)

Operation
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1 System Configuration

The following table lists system configurations for connecting Hitachi Industrial Equipment Systems Co., Ltd. 

External Devices and the Display.

Series Name CPU Link I/F SIO Type
Setting 

Example

H

H-4010(CPU3-40H)
H-2002(CPU2-20H)
H-1002(CPU2-10H)
H-702(CPU2-07H)
H-302(CPU2-03H)

LAN_ETH2
LAN_ETH

Ethernet
(TCP)

Setting 
Example 1 
(page 8)

Ethernet
(UDP)

Setting 
Example 2 
(page 10)

EH-150

EH-150(EH-CPU548)
EH-150(EH-CPU516)
EH-150(EH-CPU448A)
EH-150(EH-CPU448)
EH-150(EH-CPU316A)
EH-150(EH-CPU308A)

EH-ETH*1

Ethernet
(TCP)

Setting 
Example 3 
(page 12)

Ethernet
(UDP)

Setting 
Example 4 
(page 14)

Connector for ethernet 
on EH-ETH2

Ethernet
(TCP)

Setting 
Example 13 
(page 32)

Ethernet
(UDP)

Setting 
Example 14 
(page 34)

Web Controller
EH-WD10DR
EH-WA23DR

Ethernet port on CPU

Ethernet
(TCP)

Setting 
Example 5 
(page 16)

Ethernet
(UDP)

Setting 
Example 6 
(page 18)

EHV

EHV-CPU128
EHV-CPU64
EHV-CPU32
EHV-CPU16

Ethernet port on CPU

Ethernet
(TCP)

Setting 
Example 7 
(page 20)

Ethernet
(UDP)

Setting 
Example 8 
(page 22)

EH-ETH*1

Ethernet
(TCP)

Setting 
Example 9 
(page 24)

Ethernet
(UDP)

Setting 
Example 10 
(page 26)

Connector for ethernet 
on EH-ETH2

Ethernet
(TCP)

Setting 
Example 15 
(page 36)

Ethernet
(UDP)

Setting 
Example 16 
(page 38)
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EHV

EHV-CPU128
EHV-CPU64
EHV-CPU32
EHV-CPU16

Ethernet communication 
port on EH-ORML*2 *3

Ethernet
(TCP)

Setting 
Example 11 
(page 28)

Ethernet
(UDP)

Setting 
Example 12 
(page 30)

Ethernet communication 
port on EH-R2LH *2 *4

Ethernet
(TCP)

Setting 
Example 17 
(page 40)

Ethernet
(UDP)

Setting 
Example 18 
(page 42)

MICRO-EH
EH-20
EH-40
EH-64

Communication port on 
EH-OBETH *5

Ethernet
(TCP)

Setting 
Example 19 
(page 44)

Ethernet
(UDP)

Setting 
Example 20 
(page 47)

MICRO-EHV

MVH-A64
MVH-D64
MVH-A40
MVH-D40

Ethernet port on basic 
unit

Ethernet
(TCP)

Setting 
Example 21 
(page 50)

*1 When connecting with Display, EH-ETH with SOFTWARE VER.06 or later is required. (Check the             
label of EH-ETH main body for the version.)

*2 The following CPU ROM versions are required to use the remote communications module.

*3 EH-ORMM is required to use EH-ORML.

*4 EH-RMAH is required to use EH-R2LH.

*5 The following CPU ROM versions are required to use EH-OBETH.

Series Name CPU Link I/F SIO Type
Setting 

Example

CPU Supported versions

EHV-CPU128 ROM Ver.0117 or later

EHV-CPU64 ROM Ver.1117 or later

EHV-CPU32 ROM Ver.2117 or later

EHV-CPU16 ROM Ver.3117 or later

CPU Supported versions

EH-20 MFG No. 05Gxx or later

EH-40 MFG No. 05Gxx or later

EH-64 MFG No. 05Gxx or later
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 Connection Configuration

[1:1 Connection]

[1:n Connection]

[n:1Connection]

[n:m Connection]

Display External Device

HUB
Ethernet

Unit

Display External Device

HUB

Ethernet

Unit

External Device

Ethernet

Unit

Ethernet

UDP Connection: Up to 32 units

TCP Connection: Up to 16 units

Display

HUB
Ethernet

H Series, 
MICRO-EH Series: Up to 2 units
EH-150 Series, EHV Series,
Web Controller: Up to 4 units

Display

Ethernet Unit

Display

HUB
Ethernet

H Series, 
MICRO-EH Series: Up to 2 units
EH-150 Series, EHV Series,
Web Controller: Up to 4 units

Display External Device

Ethernet Unit

External Device

Ethernet Unit

UDP Connection: Up to 32 units
TCP Connection: Up to 16 units
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[Multiple CPU link]

Web Controller does not support this configuration.

[When using the optical remote communications module]

[When using the coaxial remote communications module]

• For slave stations at the end of the cable, TxD-T and RxD-T on coaxial remote communications 

modules must be terminated.

Display External Device

HUB

Ethernet Unit

External Device

CPU Link

Unit

Ethernet

External Device on Ethernet Network

UDP Connection: Up to 32 units

TCP Connection: Up to 16 units

CPU Link

CPU Link

Unit

External Device using CPU Link:

Up to 64 units

External Device

CPU Link

Unit

Display

HUB

Ethernet

Master
station

Slave
station

Optical remote communications module

EH-ORMM

Optical remote communications module

EH-ORML

Optical cable

External
Device

External
Device

Display

HUB
Ethernet

Master
station

Slave
station

Coaxial remote communications module
EH-RMAH

Coaxial remote communications module
EH-R2LH

Coaxial cable

External
Device

External
Device



H Series Ethernet Driver   

GP-Pro EX Device/PLC Connection Manual 7

2 External Device Selection

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Hitachi IES Co., Ltd.".

Series

Select the External Device model (series) and the connection method. Select "H Series 
Ethernet".
In System configuration, make sure the External Device you are connecting is supported by 
"H Series Ethernet".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Communication Settings

Examples of communication settings of the Display and the External Device, recommended by Digital 

Electronics Corp., are shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (LAN-ETH, LAN-ETH2)

Use the ladder software (Ladder Editor for Windows) to enter the value for appointed I/O No. for communication 

setting.

Please refer to the manual of the ladder software for more details.

1. Assign the Ethernet unit in the CPU unit.

Perform the environmental setting to allow the CPU unit to communicate with the ladder software.

2. Use [I/O assign] in the ladder software to assign the Ethernet unit to I/O.

3. Use [CPU Write] in the ladder software to write the I/O assignment setting in the External Device.

That completes the environmental setting of the External Device.

4. Next, perform the communication settings of the External Device.

Set the DIP Switch of the Ethernet unit as shown below.

The setting below enables to set the IP address of the Ethernet unit.

5. Enter IP address or port No. for appointed I/O No. in the I/O monitor of the ladder software.

I/O No. to be entered varies depending on the slot position to which the Ethernet unit is assigned. 

Please refer to the manual of the External Device for more details.

6. Write the communication setting in the Ethernet unit.

Display the address "R0" in I/O monitor of the ladder software and enter 1 for the setting value in the [Force 

Set/Reset] dialog box.

7. Turn OFF the power of the External Device. After turning OFF DIP Switches 5 to 8 in the Ethernet unit, turn 

ON the power of the External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

DIP Switch Settings Requirements

1 OFF Mode Selection (Always OFF)

2 ON*1

*1 For LAN-ETH2, always set OFF (10BASE-T only). 

10BASE-T(ON)/10BASE-5(OFF) Switch

3 OFF Reservation (Always OFF)

4 OFF IP address rewrite setting (OFF: Rewritable)

5 OFF

Selection by function type
You can set IP address at the status on the left.

6 ON

7 ON

8 OFF
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (LAN-ETH, LAN-ETH2)

Use the ladder software (Ladder Editor for Windows) to enter the value for appointed I/O No. for communication 

setting.

Please refer to the manual of the ladder software for more details.

1. Assign the Ethernet unit in the CPU unit.

Perform the environmental setting to allow the CPU unit to communicate with the ladder software.

2. Use the [I/O assign] of the ladder software to assign the Ethernet unit to I/O.

3. Use [CPU Write] in the ladder software to write the I/O assignment setting in the External Device.

That completes the environmental setting of the External Device.

4. Next, perform the communication settings of the External Device.

Set the DIP Switch of the Ethernet unit as shown below.

The setting below enables to set the IP address of the Ethernet unit.

5. Enter IP address or port No. for appointed I/O No. in the I/O monitor of the ladder software.

I/O No. to be entered varies depending on the slot position to which the Ethernet unit is assigned.

Please refer to the manual of the External Device for more details.

6. Write the communication setting in the Ethernet unit.

Display the address "R0" in I/O monitor of the ladder software and enter 1 for the setting value in the [Force 

Set/Reset] dialog box.

7. Turn OFF the power of the External Device. After turning OFF DIP Switches 5 to 8 in the Ethernet unit, turn 

ON the power of the External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

DIP Switch Settings Requirements

1 OFF Mode Selection (Always OFF)

2 ON*1

*1 For LAN-ETH2, always set OFF (10BASE-T only). 

10BASE-T(ON)/10BASE-5(OFF) Switch

3 OFF Reservation (Always OFF)

4 OFF IP address rewrite setting (OFF: Rewritable)

5 OFF

Selection by function type
You can set IP address at the status on the left.

6 ON

7 ON

8 OFF
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (EH-ETH)

Use the Web Browser to access the Ethernet unit for communication setting.

Note that the ladder software (Ladder Editor for Windows) is used for setting up the environment of the External 

Device.

Please refer to the manual of the EH-ETH for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Enter "http://192.168.0.4/" in the address input box of the Web Browser to access the Ethernet unit.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Select [IP Address] from the menu frame in the displayed screen and set IP address.

6. Similarly, select [Task Code] from the menu frame and set [Port No.] and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

7. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.3 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Ethernet Information 

Setting Mode
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (EH-ETH)

Use the Web Browser to access the Ethernet unit for communication setting.

Note that the ladder software (Ladder Editor for Windows) is used for setting up the environment of the External 

Device.

Please refer to the manual of the EH-ETH for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Enter "http://192.168.0.4/" in the address input box of the Web Browser to access the Ethernet unit.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Select [IP Address] from the menu frame in the displayed screen and set IP address.

6. Similarly, select [Task Code] from the menu frame and set [Port No.] and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

7. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.3 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Ethernet Information 

Setting Mode
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [Web Controller Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (Web Controller)

Use a Web Browser to access the External Device communication settings.

Please refer to the manual of the Web Controller for more details.

1. By setting up the Operation Mode Setting Switch of the External Device as shown below, the temporary IP 

address of the Ethernet port will be set to "192.168.0.1".

<Operation Mode Setting Switch>

EH-WD10DR: Set the Rotary switch to "2".

EH-WA23DR: Turn ON the DIP Switch 4 only.

2. Connect the PC’s Ethernet port and the Web Controller’s Ethernet port by LAN cable. (Connect via HUB or 

connect directly using a cross cable.)

3. Enter "http://192.168.0.1/mwconfig.cgi" in the address input box of the Web Browser to access the External 

Device.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

4. Login in the displayed System Configuration Login screen.

5. Select [Ethernet Protocol]-[Passive HIProtocol] from [System Configuration] and set [Task Code Port] and 

[Port No.].

6. Similarly, select [IP Address] from [System Configuration] in the displayed screen and set IP address.

Also, please set [Task Code Port], [Port No.] and the IP Address as the same value as those set on the Display 

side.

7. Setup the Operation Mode Setting Switch of the External Device as shown below, and turn the power ON 

again.

<Operation Mode Setting Switch>

EH-WD10DR: Set the Rotary switch to "0".

EH-WA23DR: Turn OFF the all DIP Switches.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• The Web Controller will be rebooted after IP address settings. 

Enter "http://192.168.0.1/mwconfig.cgi" in the address input box of the Web Browser, and login on 

the System Configuration Login screen. Then, check the settings.
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3.6 Setting Example 6

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [Web Controller Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (Web Controller)

Use a Web Browser to access the External Device communication settings.

Please refer to the manual of the Web Controller for more details.

1. By setting up the Operation Mode Setting Switch of the External Device as shown below, the temporary IP 

address of the Ethernet port will be set to "192.168.0.1".

<Operation Mode Setting Switch>

EH-WD10DR: Set the Rotary switch to "2".

EH-WA23DR: Turn ON the DIP Switch 4 only.

2. Connect the PC’s Ethernet port and the Web Controller’s Ethernet port by LAN cable. (Connect via HUB or 

connect directly using a cross cable.)

3. Enter "http://192.168.0.1/mwconfig.cgi" in the address input box of the Web Browser to access the External 

Device.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

4. Login in the displayed System Configuration Login screen.

5. Select [Ethernet Protocol]-[Passive HIProtocol] from [System Configuration] and set [Task Code Port] and 

[Port No.].

6. Similarly, select [IP Address] from [System Configuration] in the displayed screen and set IP address.

Also, please set [Task Code Port], [Port No.] and the IP Address as the same value as those set on the Display 

side.

7. Setup the Operation Mode Setting Switch of the External Device as shown below, and turn the power ON 

again.

<Operation Mode Setting Switch>

EH-WD10DR: Set the Rotary switch to "0".

EH-WA23DR: Turn OFF the all DIP Switches.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• The Web Controller will be rebooted after IP address settings. 

Enter "http://192.168.0.1/mwconfig.cgi" in the address input box of the Web Browser, and login on 

the System Configuration Login screen. Then, check the settings.
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3.7 Setting Example 7

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (Ethernet Port on EHV-CPU)

Use the programming software (Control Editor) for communication settings.

Please refer to the manual of the EHV for more details.

1. Start the programming software and create the project. The project appears in the offline mode.

2. Select [Editor Communication Setting] from the [Tool] menu to display the communication setting dialog box.

3. Select the communication method to transfer the External Device between "USB" and "Serial", and then click 

[Setting].

4. Connect the PC and the External Device by a USB cable or a serial cable (Hitachi IES Co., Ltd.).

5. Select [Mode Change] - [Online] from the [Online] menu to move to the online mode.

6. Select [CPU Setting] - [IP Address Setting] from the [Tool] menu to set IP address.

7. Select [CPU Setting] - [Ethernet Communication (Task Code) Setting] from the [Tool] menu to set [Port No.] 

and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

8. Turn ON the power of the External Device again.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.
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3.8 Setting Example 8

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (Ethernet Port on EHV-CPU)

Use the programming software (Control Editor) for communication settings.

Please refer to the manual of the EHV for more details.

1. Start the programming software and create the project. The project appears in the offline mode.

2. Select [Editor Communication Setting] from the [Tool] menu to display the communication setting dialog box.

3. Select the communication method to transfer the External Device between "USB" and "Serial", and then click 

[Setting].

4. Connect the PC and the External Device by a USB cable or a serial cable (Hitachi IES Co., Ltd.).

5. Select [Mode Change] - [Online] from the [Online] menu to move to the online mode.

6. Select [CPU Setting] - [IP Address Setting] from the [Tool] menu to set IP address.

7. Select [CPU Setting] - [Ethernet Communication (Task Code) Setting] from the [Tool] menu to set [Port No.] 

and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

8. Turn ON the power of the External Device again.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.
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3.9 Setting Example 9

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (EH-ETH)

Use the Web Browser to access the Ethernet unit for communication setting.

Note that the ladder software (Control Editor) is used for setting up the environment of the External Device.

Please refer to the manual of the EH-ETH for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Enter "http://192.168.0.4/" in the address input box of the Web Browser to access the Ethernet unit.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Select [IP Address] from the menu frame in the displayed screen and set IP address.

6. Similarly, select [Task Code] from the menu frame and set [Port No.] and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

7. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.3 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Ethernet Information 

Setting Mode
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3.10 Setting Example 10

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 Settings of External Device (EH-ETH)

Use the Web Browser to access the Ethernet unit for communication setting.

Note that the ladder software (Control Editor) is used for setting up the environment of the External Device.

Please refer to the manual of the EH-ETH for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Enter "http://192.168.0.4/" in the address input box of the Web Browser to access the Ethernet unit.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Select [IP Address] from the menu frame in the displayed screen and set IP address.

6. Similarly, select [Task Code] from the menu frame and set [Port No.] and [Protocol].

Also, please set the IP Address, [Port No.] and [Protocol] as the same value as those set on the Display side.

7. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.3 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Ethernet Information 

Setting Mode
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3.11 Setting Example 11

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Ethernet communications port on the EH-ORML)

For communications settings, use the station setting SW (rotary switch), the mode setting SW (DIP Switch) on the 

slave station communications module, and the EH remote slave station IP address setting tool (Version 1.00).

Refer to your External Device manual for details.

1. Set the station setting SW on the slave station communications module to the "0" position.

2. Set [8:TERM] of the mode setting SW on the slave station communications module to the ON position.

3. Turn on the power.

4. Read out the CPU settings on the master station and the current values of the slave station communications 

module. Refer to your External Device manual for details.

5. Set [5:INIT] of the mode setting SW on the slave station communications module to the ON position.

6. Start up the EH remote slave station IP address setting tool.

7. Click [Connect] and read out the current setting values.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

8. Set each item as follows:

• IP Address Setting

• Logic Port No. Setting (Port1)

9. Click [Set].

10. Confirm the setting complete message and press [OK].

11. Set [5:INIT] of the SW mode setting on the slave station communications module to the OFF position.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• To connect multiple slave stations, set the station setting SWs on the slave station communications 

modules to the "0, 1, 2, ..., 9" positions, starting with the station closest to the master station.

• To connect multiple slave stations, set [8:TERM] of the mode setting SW only on the slave station 

communications module that terminates the connection, to the ON position.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

Transmission Speed/System AUTO

Setup Items Setting

Port No. 3004

Protocol TCP/IP
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3.12 Setting Example 12

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Ethernet communications port on the EH-ORML)

For communications settings, use the station setting SW (rotary switch), the mode setting SW (DIP Switch) on the 

slave station communications module, and the EH remote slave station IP address setting tool (Version 1.00).

Refer to your External Device manual for details.

1. Set the station setting SW on the slave station communications module to the "0" position.

2. Set [8:TERM] of the mode setting SW on the slave station communications module to the ON position.

3. Turn on the power.

4. Read out the CPU settings on the master station and the current values of the slave station communications 

module. Refer to your External Device manual for details.

5. Set [5:INIT] of the mode setting SW on the slave station communications module to the ON position.

6. Start up the EH remote slave station IP address setting tool.

7. Click [Connect] and read out the current setting values.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

8. Set each item as follows:

• IP Address Setting

• Logic Port No. Setting (Port1)

9. Click [Set].

10. Confirm the setting complete message and press [OK].

11. Set [5:INIT] of the SW mode setting on the slave station communications module to the OFF position.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• To connect multiple slave stations, set the station setting SWs on the slave station communications 

modules to the "0, 1, 2, ..., 9" positions, starting with the station closest to the master station.

• To connect multiple slave stations, set [8:TERM] of the mode setting SW only on the slave station 

communications module that terminates the connection, to the ON position.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

Transmission Speed/System AUTO

Setup Items Setting

Port No. 3004

Protocol UDP/IP
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3.13 Setting Example 13

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Connector for ethernet on EH-ETH2)

Use the setting tool (EH-ETH2 Configurator) for communication setting.

Note that the ladder software (Ladder Editor for Windows) is used for setting up the environment of the External 

Device.

Please refer to the manual of the EH-ETH2 for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH2’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Start the setting tool.

5. Select [Communication Setting] from the [Option] menu.

6. Enter "192.168.0.4" in the IP address input box and click [OK].

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

7. Click [Set Ethernet Parameters] to display the setting dialog box.

8. Click [Online] and read out the current setting values.

9. Set each item as follows:

• IP Address Set

• Task Code Logical Port No. Set (Port1)

10. Click [Set] to display the setting complete dialog box and click [OK].

11. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.4 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Communications Parameter 

Setting Mode

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Transfer speed / Type Auto Negotiation

Setup Items Setting

Port No. 3004

Protocol TCP/IP
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3.14 Setting Example 14

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Connector for ethernet on EH-ETH2)

Use the setting tool (EH-ETH2 Configurator) for communication setting.

Note that the ladder software (Ladder Editor for Windows) is used for setting up the environment of the External 

Device.

Please refer to the manual of the EH-ETH2 for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH2’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Start the setting tool.

5. Select [Communication Setting] from the [Option] menu.

6. Enter "192.168.0.4" in the IP address input box and click [OK].

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

7. Click [Set Ethernet Parameters] to display the setting dialog box.

8. Click [Online] and read out the current setting values.

9. Set each item as follows:

• IP Address Set

• Task Code Logical Port No. Set (Port1)

10. Click [Set] to display the setting complete dialog box and click [OK].

11. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.4 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Communications Parameter 

Setting Mode

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Transfer speed / Type Auto Negotiation

Setup Items Setting

Port No. 3004

Protocol UDP/IP
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3.15 Setting Example 15

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Connector for ethernet on EH-ETH2)

Use the setting tool (EH-ETH2 Configurator) for communication setting.

Note that the ladder software (Control Editor) is used for setting up the environment of the External Device.

Please refer to the manual of the EH-ETH2 for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH2’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Start the setting tool.

5. Select [Communication Setting] from the [Option] menu.

6. Enter "192.168.0.4" in the IP address input box and click [OK].

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

7. Click [Set Ethernet Parameters] to display the setting dialog box.

8. Click [Online] and read out the current setting values.

9. Set each item as follows:

• IP Address Set

• Task Code Logical Port No. Set (Port1)

10. Click [Set] to display the setting complete dialog box and click [OK].

11. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.4 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Communications Parameter 

Setting Mode

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Transfer speed / Type Auto Negotiation

Setup Items Setting

Port No. 3004

Protocol TCP/IP
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3.16 Setting Example 16

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Connector for ethernet on EH-ETH2)

Use the setting tool (EH-ETH2 Configurator) for communication setting.

Note that the ladder software (Control Editor) is used for setting up the environment of the External Device.

Please refer to the manual of the EH-ETH2 for more details.

1. Assign the Ethernet unit to CPU unit by using [I/O assign] in the ladder software.

2. Turn ON the DIP Switch 1 and 6 of the Ethernet unit, and turn ON the power. Then, a temporary address 

(192.168.0.4) for accessing the Ethernet unit will be set.

3. Connect the PC’s Ethernet port and the EH-ETH2’s Ethernet port by LAN cable. (Connect via HUB or connect 

directly using a cross cable.)

4. Start the setting tool.

5. Select [Communication Setting] from the [Option] menu.

6. Enter "192.168.0.4" in the IP address input box and click [OK].

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

7. Click [Set Ethernet Parameters] to display the setting dialog box.

8. Click [Online] and read out the current setting values.

9. Set each item as follows:

• IP Address Set

• Task Code Logical Port No. Set (Port1)

10. Click [Set] to display the setting complete dialog box and click [OK].

11. Turn OFF the power of the External Device. After turning OFF all DIP Switches, turn ON the power of the 

External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Bit No.*1

*1 Use Bit No.4 to No.8 to set the fourth octet of IP address. The IP address is fixed to 192.168.0. until                    
the third octet.

Operation Mode
1 2 3 4 5 6 7 8

ON OFF OFF OFF OFF ON OFF OFF
Communications Parameter 

Setting Mode

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Transfer speed / Type Auto Negotiation

Setup Items Setting

Port No. 3004

Protocol UDP/IP
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3.17 Setting Example 17

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Ethernet communication port on EH-R2LH)

Use the EH remote slave station IP address setting tool (Version 1.00) for communication setting.

Please refer to the manual of the External Device for more details.

1. Set [INIT] of the mode setting SW on the slave station communications module to the "ON" position.

2. Turn on the power.

3. Start up the EH remote slave station IP address setting tool.

4. Click [Connect] and read out the current setting values.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Set each item as follows:

• IP Address Setting

• Logic Port No. Setting (Port1)

6. Click [Set].

7. Confirm the setting complete message and press [OK].

8. Turn OFF the power of the External Device. After setting OFF [INIT] of the mode setting SW on the slave sta-

tion communications module, turn ON the power of the External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• When [INIT] of the mode setting SW is set to "ON", settings are temporarily changed to following 

contents.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

Transmission Speed/System AUTO

Setup Items Setting

Port No. 3004

Protocol TCP/IP

Setup Items Setting

IP Address 192.168.0.1 (Fixed)

Subnet Mask 255.255.255.0

Default Gateway 0.0.0.0

Logic Port 3004

Communications Protocol UDP/IP

Timeout Setting None
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3.18 Setting Example 18

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Ethernet communication port on EH-R2LH)

Use the EH remote slave station IP address setting tool (Version 1.00) for communication setting.

Please refer to the manual of the External Device for more details.

1. Set [INIT] of the mode setting SW on the slave station communications module to the "ON" position.

2. Turn on the power.

3. Start up the EH remote slave station IP address setting tool.

4. Click [Connect] and read out the current setting values.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

5. Set each item as follows:

• IP Address Setting

• Logic Port No. Setting (Port1)

6. Click [Set].

7. Confirm the setting complete message and press [OK].

8. Turn OFF the power of the External Device. After setting OFF [INIT] of the mode setting SW on the slave sta-

tion communications module, turn ON the power of the External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• When [INIT] of the mode setting SW is set to "ON", settings are temporarily changed to following 

contents.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

Transmission Speed/System AUTO

Setup Items Setting

Port No. 3004

Protocol UDP/IP

Setup Items Setting

IP Address 192.168.0.1 (Fixed)

Subnet Mask 255.255.255.0

Default Gateway 0.0.0.0

Logic Port 3004

Communications Protocol UDP/IP

Timeout Setting None



H Series Ethernet Driver   

GP-Pro EX Device/PLC Connection Manual 44

3.19 Setting Example 19

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Communication port on EH-OBETH)

Set the communication setting for both the Basic unit and EH-OBETH.

Basic unit Setting

Use the ladder software (LADDER EDITOR for Windows) for communication setting.

Please refer to the manual of the ladder software for more details.

1. Select [Online] from the menu bar of the ladder software.

2. Select [I/O Monitor] from the [Window] menu.

3. Select [I/O monitor setting] from the [Edit] menu.

4. Enter "WRF03D" in [I/O No.]. Select the [Add/Insert/Overwrite 16 points from the set I/O No.] check box of 

[POINT NO.] and click [Add].

5. Select [Set Reset] from the [Monitor] menu.

6. Set the items as follows and click [Execute].

Setup Items Setting

I/O No. WRF03D

Input hexadecimal value

Set value 8300

• The setting value which is input into WRF03D is decided by the setting of each bit. The contents of 

8300H are as follows.

• When 8300H is set to WRF03D, current value is changed to 0300H.

Bit Setting Setup Description

15 1 Setting change request

14 0 Transmission procedure 1

13 0 Without station number

12 0 Not used

11-8 3H Transmission speed(38.4kbps)

7-0 0 Station number(Without station number)
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EH-OBETH Setting

Use a Web Browser to access the External Device communication settings.

Please refer to the manual of the External Device for more details.

1. Start a Web Browser on the PC.

2. Enter "http://192.168.0.1/" in the address input box of the Web Browser and press Enter key.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

3. Enter "root" in the [user name] and click [OK].

4. Select [English] from the [SELECT Language].

5. Select [NETWORK] from the MENU frame. Set the items as follows and click [OK].

6. Select [SERIAL] from the MENU frame. Set the items as follows and click [OK].

7. Select [SYSTEM] from the MENU frame.

8. Select the [SAVE] check box and click [OK].

9. Select the [REBOOT] check box to enable the changes and click [OK].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• The factory default IP address of EH-OBETH is "192.168.0.1". 

• The factory default username of EH-OBETH is "root". The password is not set.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

PROTOCOL TCP

Port No.1 3004

Port No.2 -

Setup Items Setting

Baudrate 38400

Station No. disable
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3.20 Setting Example 20

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [H/EH-150 Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Communication port on EH-OBETH)

Set the communication setting for both the Basic unit and EH-OBETH.

Basic unit Setting

Use the ladder software (LADDER EDITOR for Windows) for communication setting.

Please refer to the manual of the ladder software for more details.

1. Select [Online] from the menu bar of the ladder software.

2. Select [I/O Monitor] from the [Window] menu.

3. Select [I/O monitor setting] from the [Edit] menu.

4. Enter "WRF03D" in [I/O No.]. Select the [Add/Insert/Overwrite 16 points from the set I/O No.] check box of 

[POINT NO.] and click [Add].

5. Select [Set Reset] from the [Monitor] menu.

6. Set the items as follows and click [Execute].

Setup Items Setting

I/O No. WRF03D

Input hexadecimal value

Set value 8300

• The setting value which is input into WRF03D is decided by the setting of each bit. The contents of 

8300H are as follows.

• When 8300H is set to WRF03D, current value is changed to 0300H.

Bit Setting Setup Description

15 1 Setting change request

14 0 Transmission procedure 1

13 0 Without station number

12 0 Not used

11-8 3H Transmission speed(38.4kbps)

7-0 0 Station number(Without station number)
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EH-OBETH Setting

Use the Web Browser to access the External Device for communication setting.

Please refer to the manual of the External Device for more details.

1. Start a Web Browser on the PC.

2. Enter "http://192.168.0.1/" in the address input box of the Web Browser and press Enter key.

The login dialog box will display.

To access, PC’s IP address up to the third octet must be set to 192.168.0. (192.168.0.10, etc.)

3. Enter "root" in the [user name] and click [OK].

4. Select [English] from the [SELECT Language].

5. Select [NETWORK] from the MENU frame. Set the items as follows and click [OK].

6. Select [SERIAL] from the MENU frame. Set the items as follows and click [OK].

7. Select [SYSTEM] from the MENU frame.

8. Select the [SAVE] check box and click [OK].

9. Select the [REBOOT] check box to enable the changes and click [OK].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

• The factory default IP address of EH-OBETH is "192.168.0.1". 

• The factory default username of EH-OBETH is "root". The password is not set.

Setup Items Setting

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

PROTOCOL UDP

Port No.1 3004

Port No.2 -

Setup Items Setting

Baudrate 38400

Station No. disable
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3.21 Setting Example 21

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . Select [EHV Series] from [Series].

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• Set IP address and Port Number on the External Device in the [Individual Device Settings] dialog box.

• You need to set IP address on the Display in offline mode.
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 External Device Settings (Ethernet port on basic unit)

Use the programming software (Control Editor) for communication settings. Please refer to the manual of the 

External Device for more details.

Procedure

1. Start the programming software and create the project. The project appears in the offline mode.

2. In the tree view, from [CPU parameters] double-click [CPU settings] and [IP address]. The [CPU Communica-

tion Setting (IP Address)] dialog box will appear.

3. Set the items as follows and click [Set].

4.  In the tree view, from [CPU parameters] double-click [CPU settings] and [Ethernet (task code)]. The [CPU 

Communication Setting (Ethernet (task code))] dialog box will appear.

5. Set the port in use as follows, and then click [Set].

6. Enter online mode, and transfer the configured settings to the External Device.

7. Restart the External Device.

Notes

• Check with a network administrator about IP address. Set up unique IP addresses on the same network.

• If a time out monitoring is set up on the External Device, the connection will close if there is no 

communication within the set time frame. If you run communication while the connection is closed, although 

an error displays the connection is automatically restored.

Setup Items Setting

IP Address 192.168.0.1

Subnet mask 255.255.255.0

Default gateway 0.0.0.0

Link Speed / Duplex Auto Negotiation

Setup Items Setting Remarks

Enable ON

Number 3004 Set a number that is not duplicated on other ports.

Protocol TCP/IP

Timeout (sec.) 30 Set to 0, when not using timeout.
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4 Setup Items

Set communication settings of the Display with GP-Pro Ex or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Communication Settings" (page 8)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in offline mode.

Cf. Maintenance/Troubleshooting Guide "Ethernet Settings"

Setup Items Setup Description

Port No.

Use an integer from 1024 to 65535 to enter the port No. of the Display. When you check 
the option of [Auto], the port No. will be automatically set.

• [Auto] option is available to set only when you select "Ethernet (TCP)" in [Connecting 

Method].

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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 Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Setup Items Setup Description

Series Select a model of the External Device.

IP Address

Set IP address of the External Device.

• Check with a network administrator about IP address. Do not set the duplicate IP 

address.

Port No. Use an integer from 1024 to 65535 to enter the port No. of the External Device.
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4.2 Settings in Offline Mode

 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in the offline mode. Touch 

the External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting Guide for information on how to enter offline mode or 

about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No.

Set the Port No. of the display.
In UDP connection, entered port No. will be assigned regardless of whether you select 
[Fixed] or [Auto].
In TCP connection, select either of [Fixed] or [Auto]. When you select [Fixed], use an 
integer from 1024 to 65535 to enter the port No. of the display. When you select [Auto], the 
port No. will be automatically assigned regardless of the entered value.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
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 Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device Settings].

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of External Device set 
with GP-Pro EX.(Initial value [PLC1])

Series Display a model of the External Device.

IP Address

Set IP address of the External Device.

Check with a network administrator about IP address. Do not set the duplicate IP address.

Port No. Use an integer from 1024 to 65535 to enter the port No. of the External Device.
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5 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

5.1 H / EH-150 / MICRO-EH Series

 This address can be specified as system data area.         

Device Bit Address Word Address
Double Word

Address
32 bit Remarks

External Input X00000-X05A95
WX0000-
WX05A7

DX0000-DX05A6 *1 *2

*1 Write disable

External Output Y00000-Y05A95
WY0000-
WY05A7

DY0000-DY05A6 *2

Remote Input Relay X10000-X49995 WX1000-WX4997 DX1000-DX4996 *1 *3

Remote Output Relay Y10000-Y49995 WY1000-WY4997 DY1000-DY4996 *3 

Inner Output R000-R7BF - -

Special Inner Output R7C0-R7FF - -

Data Area M0000-M3FFF WM000-WM3FF DM000-DM3FE

First CPU Link L00000-L03FFF WL0000-WL03FF DL0000-DL03FE

Second CPU Link L10000-L13FFF WL1000-WL13FF DL1000-DL13FE

On Delay Timer TD000 -TD255 - -

Single-shot Timer SS000-SS255 - -

Watchdog Timer
WDT000-
WDT255

- -

Mono Stable Timer MS000-MS255 - -

Retentive Timer TMR000-TMR255 - -

Up Counter CU000-CU511 - -

Ring Counter RCU000-RCU511 - -

Up-down Counter CT000-CT511 - -

Timer Counter
(Elapsed Value)

- TC000-TC511 -

Word Inner Output -
WR0000-
WRC3FF

DR0000-DRC3FE

Network Link Area -
WN0000-
WN7FFF

DN0000-DN7FFE
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*2 Specify as shown below.

 (Example) External input unit No.1, Slot No.2, Inner Module Bit No.34

 (Example) External input unit No.1, Slot No.2, Inner Module Word No.3

*3 Specify as shown below.

(Example) Remote External Input Remote Master No.1, Remote Slave No.2, Slot No.3, Inner Module Bit No.45

(Example) Remote External Input Remote Master No.1, Remote Slave No.2, Slot No.3, Inner Module Word              
No.4

• Available type and range of device vary depending on CPU. Be sure to check them in each CPU 

manual before using.

X 0 1 2 3 4

Module Bit No. (00-95, decimal)

Slot No. (0-A, hexadecimal)

Unit No. (0-5)

W X 0 1 2 3

Module Word No.(0-7)

Slot No.(0-A, hexadecimal)

Unit No.(0-5)

X 1 2 3 4 5

Module Bit No.(0-95)

Slot No.(0-9)

Remote Slave No.(0-9)

Remote Master No.(1-4)

W X 1 2 3 4

Module Word No.(0-7)

Slot No.(0-9)

Remote Slave No.(0-9)

Remote Master No.(1-4)
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 CPU How to set address when using the link

Set the check box of "Use CPU Link" to ON.

When using CPU Link, loop No. and unit No. are added to the address.

(Example) Loop No.1, Unit No.2

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

1/ 2/ WR0000

Device Address

CPU Link Unit No.

CPU Link Loop No.
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5.2 Web Controller Series

 This address can be specified as system data area.         

Device Bit Address Word Address
Double Word

Address
32 bits Remarks

External Input

X0000-X0012
X1000-X1015
X2000-X2015
X3000-X3015
X4000-X4015

WX030-WX031
WX100-WX104
WX200-WX204
WX300-WX304
WX400-WX404

DX030
DX100-DX103
DX200-DX203
DX300-DX303
DX400-DX403

*1

*1 Write disable

External Output

Y0100-Y0109
Y1016-Y1031
Y2016-Y2031
Y3016-Y3031
Y4016-Y4031

WY40
WY105-WY107
WY205-WY207
WY305-WY307
WY405-WY407

DY105-DY106
DY205-DY206
DY305-DY306
DY405-DY406

Inner Output R000-R7BF - -

Special Inner Output R7C0-R7FF - -

Data Area M0000-M3FFF WM000-WM3FF DM000-DM3FE

On Delay Timer TD000-TD255 - - *2

*2 Each timer or counter needs to be defined on the ladder program.

Single-shot Timer SS000-SS255 - - *2

Up Counter CU000-CU255 - - *2

Up-down Counter CT000-CT255 - - *2*3

*3 Both the Up-down counter Up input and Down input are defined by CT, however, the device names of the                  
External Device are CTU, CTD respectively.

To access CTU, define the corresponding address as CTU on the ladder program of the External Device.                
Similarly, to access CTD, define the corresponding address as CTD on the ladder program of the External                
Device.

Timer Counter
(Elapsed Value)

- TC000-TC255 -

Word Inner Output -
WR0000-
WRC3FF

DR0000-DRC3FE
*4

*4 For EH-WD10DR, the address range is [WR0000-WR3FFF] for Word Address and [DR0000-DR3FFE] for            
Double Word Address.

Word Special Inner 
Output

WRF000-
WRF1FF

DRF000-DRF1FE

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.3 EHV Series

 This address can be specified as system data area.         

Device Bit Address Word Address
Double Word

Address
32 bit Remarks

External Input X00000-X05A95
WX0000-
WX05A7

DX0000-DX05A6 *1 *2

External Output Y00000-Y05A95
WY0000-
WY05A7

DY0000-DY05A6 *2

Remote Input Relay X10000-X49A95
WX1000-
WX49A7

DX1000-DX49A6 *1 *3 *4

Remote Output Relay Y10000-Y49A95
WY1000-
WY49A7

DY1000-DY49A6 *3 *4

Extension External Input
EX00000-
EX5A7FF

WEX0000-
WEX5A7F

DEX0000-
DEX5A7E

*1

Extension External Output
EY00000-
EY5A7FF

WEY0000-
WEY5A7F

DEY0000-
DEY5A7E

Inner Output R000-R7BF - -

Data Area M00000-M7FFFF
WM0000-
WM7FFF

DM0000-
DM7FFE

First CPU Link L00000-L03FFF WL0000-WL03FF DL0000-DL03FE

Second CPU Link L10000-L13FFF WL1000-WL13FF DL1000-DL13FE

Third CPU Link L20000-L23FFF WL2000-WL23FF DL2000-DL23FE

Fourth CPU Link L30000-L33FFF WL3000-WL33FF DL3000-DL33FE

Fifth CPU Link L40000-L43FFF WL4000-WL43FF DL4000-DL43FE

Sixth CPU Link L50000-L53FFF WL5000-WL53FF DL5000-DL53FE

Seventh CPU Link L60000-L63FFF WL6000-WL63FF DL6000-DL63FE

Eighth CPU Link L70000-L73FFF WL7000-WL73FF DL7000-DL73FE

On Delay Timer TD0000-TD2559 - -

Off Delay Timer
TDN0000-
TDN2559

- -

Single-shot Timer SS0000-SS2559 - -

Watchdog Timer
WDT0000-
WDT2559

- -

Mono Stable Timer MS0000-MS2559 - -

Retentive Timer
TMR0000-
TMR2559

- -

Up-down Counter CT000-CT511 - -

Up Counter CU000-CU511 - -

Ring Counter RCU000-RCU511 - -
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Timer Counter
(Elapsed Value)

- TC0000-TC2559 -

Word Inner Output
WR00000-
WREFFFF

WR0000-
WREFFF

DR0000-DREFFE

Data Area
WN000000-
WN1FFFFF

WN00000-
WN1FFFF

DN00000-
DN1FFFE

*1 Write disable

*2 Specify as shown below.

 (Example) External input unit No.1, Slot No.2, Inner Module Bit No.34

 (Example) External input unit No.1, Slot No.2, Inner Module Word No.3

*3 Specify as shown below.

(Example) Remote External Input Remote Master No.1, Remote Slave No.2, Slot No.3, Inner Module Bit No.45

(Example) Remote External Input Remote Master No.1, Remote Slave No.2, Slot No.3, Inner Module Word              
No.4

Device Bit Address Word Address
Double Word

Address
32 bit Remarks

X 0 1 2 3 4

Module Bit No.(00-95, decimal)

Slot No.(0-A, hexadecimal)

Unit No.(0-5)

W X 0 1 2 3

Module Word No.(0-7)

Slot No.(0-A, hexadecimal)

Unit No.(0-5)

X 1 2 3 4 5

Module Bit No.(0-95, decimal)

Slot No.(0-A, hexadecimal)

Remote Slave No.(0-5)

Remote Master No.(1-4)

W X 1 2 3 4

Module Word No.(0-7)

Slot No.(0-A, hexadecimal)

Remote Slave No.(0-5)

Remote Master No.(1-4)
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 When using CPU Link

Set the check box of "Use CPU Link" to ON.

When using CPU Link, loop No. and unit No. are added to the address.

(Example) Loop No.1, Unit No.2

*4 When using the optical remote communications module, specify as shown below:
(Example) Master Station No.1, Slave Station No.2, Slot No.3, Inner Module Bit No.45

(Example) Master Station No.1, Slave Station No.2, Slot No.3, Inner Module Word No.4

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

X 1 2 3 4 5

Module Bit No.(0-95, decimal)

Slot No.  The slot next to EH-ORML is 0. (0-A, hexadecimal)

Slave Station No.(0-9)

Master Station No.(1-4)

W X 1 2 3 4

Module Word No.(0-7)

Slot No.  The slot next to EH-ORML is 0. (0-A, hexadecimal)

Slave Station No.(0-9)

Master Station No.(1-4)

1/ 2/ WR0000

Device Address

CPU Link Unit No.

CPU Link Loop No.
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5.4 MICRO-EHV Series

 This address can be specified as system data area.         

Device Bit Address Word Address
Double Word

Address
32 bits Remarks

External Input X0000 – X0039 WX000 – WX002 DX000 *1

*1 Write disable

External Output Y0100 – Y0123 WY010 – WY011 DY000

Inner Output R000 – R7BF - -

Special Inner Output R7C0 – RFFF - -

Data Area M0000 – M7FFF
WM000 – 
WM7FF

DM000 – DM7FE

On Delay Timer TD0000 - TD2047 - -

Off Delay Timer
TDN0000 – 
TDN2047

Single-shot Timer SS0000 – SS2047 - -

Watchdog Timer
WDT0000 – 
WDT2047

- -

Mono Stable Timer
MS0000 – 
MS2047

- -

Retentive Timer
TMR0000 – 
TMR2047

- -

Up-down Counter CT000 – CT511 - -

Up Counter CU000 – CU511 - -

Ring Counter
RCU000 – 
RCU511

- -

Timer Counter (Elapsed 
Value)

- TC0000 – TC2047 -

Word Inner Output
WR0000.0 – 
WR7FFF.F

WR0000 – 
WR7FFF

DR0000 – 
DR7FFE

Word Special Inner 
Output

WRF000.0 – 
WRF1FF.F

WRF000 – 
WRF1FF

DRF000 – 
DRF1FE

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

6.1 H / EH-150 / MICRO-EH Series

Device Device Name
Device Code

(HEX)
Address Code

Input Relay

X
0080

Word Address

WX Word Address

DX 0020 Word Address

Output Relay

Y
0081

Word Address

WY Word Address

DY 0021 Word Address

Data Area

M
0082

Word Address

WM Word Address

DM 0022 Word Address

CPU Link

L
0083

Word Address

WL Word Address

DL 0023 Word Address

Timer Counter
(Elapsed Value)

TC 0060 Word Address

Word Inner Output
WR 0000 Word Address

DR 0024 Word Address

Network Link Area
WN 0001 Word Address

DN 0025 Word Address
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6.2 Web Controller Series

Device Device Name
Device Code

(HEX)
Address Code

External Input

X
0080

Word Address

WX Word Address

DX 0020 Word Address

External Output

Y
0081

Word Address

WY Word Address

DY 0021 Word Address

Inner Output

M
0082

Word Address

WM Word Address

DM 0022 Word Address

Timer Counter
(Elapsed Value)

TC 0060 Word Address

Word Inner Output
Word Special Inner Output

WR 0000 Word Address

DR 0024 Word Address
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6.3 EHV Series

Device Device Name
Device Code

(HEX)
Address Code

External Input

X
0080

Word Address

WX Word Address

DX 0020 Word Address

External Output

Y
0081

Word Address

WY Word Address

DY 0021 Word Address

Extension External Input

EX
0084

Word Address

WEX Word Address

DEX 0026 Word Address

Extension External Output

EY
0085

Word Address

WEY Word Address

DEY 0027 Word Address

Data Area

M
0082

Word Address

WM Word Address

DM 0022 Word Address

CPU Link

L
0083

Word Address

WL Word Address

DL 0023 Word Address

Word Inner Output
WR 0000 Word Address

DR 0024 Word Address

Data Area
WN 0001 Word Address

DN 0025 Word Address

Timer Counter
(Elapsed Value)

TC 0060 Word Address
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6.4 MICRO-EHV Series

Device Device Name
Device Code

(HEX)
Address Code

External Input

W
0080

Word Address

WX Word Address

DX 0020 Word Address

External Output

Y
0081

Word Address

WY Word Address

DY 0021 Word Address

Data Area

M
0082

Word Address

WM Word Address

DM 0022 Word Address

Timer Counter
(Elapsed Value)

TC 0060 Word Address

Word Inner Output
WR 0000 Word Address

DR 0024 Word Address

Word Special Inner Output
WRF 0001 Word Address

DRF 0025 Word Address
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7 Error Messages

Error messages are displayed on the screen of the Display as follows: "No.:Device Name:Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: [02H,02H])"

 Error Codes Unique to External Device

Error codes are sent as separated 2 bytes codes

Example:

Item Requirements

No. Error Number.

Device Name
Name of the External Device where error occurs. Device name is a title of the External 
Device set with GP-Pro EX.(Initial value[PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of the External Device where error occurs, or error 
codes received from the External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "[Hex, Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error 

messages common to the driver.

Error Code Description

01,05 The requested number of points is beyond the designated range.

01,06 Designated device does not exist.

01,07 Designated device address is beyond the range.

• Please refer to the manual of the External Device for more detail of received error codes.

Reply Command

01

Return Code

07

Display Error

01,07
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 Error Messages Unique to External Device

Error Code Error Message Description

RHxx128
(Node Name): Error has been responded for 
initial communication command (Error Code: 
[Hex,Hex])

After sending a communication start request to 
the External Device, it returned an error 
response.

RHxx129
(Node Name): Error has been responded for 
device read command (Error Code: 
[Hex,Hex])

After sending a read request to the External 
Device, it returned an error response.

RHxx130
(Node Name): Error has been responded for 
device write command (Error Code: 
[Hex,Hex])

After sending a write request to the External 
Device, it returned an error response.

RHxx131
(Node Name): Error has been responded for 
device read command (Error Code: 
[Hex,Hex] There are out of range devises)

After sending a read request to the External 
Device, it returned an error response. Check the 
read address.

RHxx132
(Node Name): Error has been responded for 
device write command (Error Code: 
[Hex,Hex]) There are out of range devises)

After sending a write request to the External 
Device, it returned an error response. Check the 
write address.

RHxx133

(Node Name): Error has been responded for 
Read Occupancy command (Error Code: 
[Hex,Hex]) Local station is WRITE-occupy-
ing CPU)

After sending a read occupancy request to the 
External Device, it returned an error response. 
Release the write occupancy held by the local 
node.

RHxx134

(Node Name): Error has been responded for 
Read Occupancy command (Error Code: 
[Hex,Hex]) Already READ-occupied by the 
other four stations)

After sending a read occupancy request to the 
External Device, it returned an error response. 
Release the read occupancy held by other nodes.

RHxx135

(Node Name): Error has been responded for 
Read Occupancy command (Error Code: 
[Hex,Hex]) Another station is WRITE-occu-
pying CPU)

After sending a read occupancy request to the 
External Device, it returned an error response. 
Release the write occupancy held by other nodes.
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